duia )Vl Liaglgifilig rogl=ll Azola dulkh alail
Cr9_rad) g L*Jh.'ﬂ 5 gall

addylw Glgiw dliwi
Waowlall gl ylaiod

e bty allall gy pdall Do o (el Ao gl Laline § Bolzud]
il g LYl ug - 0255V1s SLusY! (. dudiy SludY gy
w Buzg agals L 3§ logho US LSuid
. JSU 185 Lo 5,80 a9
ws) ISy & i .. ygudall S LISy




CD-ROM stands for:

a. Compact Disk Random Only Memory

b. Compact Disk Read Only Memory

c. Computer Device Read Only Memory

d. Computer Disk Random Online Memory

Control Unit (CU) is the:

a. Main unit of the computer and sometimes is called the brain of the
computer

b. Unit that controls and coordinates all other computer components
c. Main memaory of any computer system

d. Unit that is responsible for performing all the computer calculations
Which of the following factors you should consider when buying a
computer:

a. Size of the RAM

b. Speed of the CPU

c. Size of the hard disk

d. All of the above

The term "end user" is used to describe people who:

a. use the output from computers (the end product).

b. write software for computers.

c. use computers to perform information processing tasks.

d. are the last to use a computer or the information from a computer.
In which areas of today's business world would you expect to find
microcomputers?

a. In nearly all areas of business.

b. Only in areas that require extensive mathematical processing.

c. In areas that demand exact answers or word processing.

d. In large corporations with big data processing budgets.

The largest computers, used mainly for research, are called:

a. microcomputers.

b. maxicomputers.

¢. supercomputers.

d. mainframe computers.

The raw material used to create information is called:

a. metaware. b. hardware.

c. data. d. manuals/procedures.
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Software used to interact between user programs and the computer is
called:

a. application software.

b. system software.

C. operation software.

d. custom made software.

Microcomputers are divided into two general categories:

a. high speed and low speed.

b. graphical and non-graphical.

c. portable and desktop.

d. math based and text based.

An example of data is:

a. the average rainfall in Amman for 1995.

b. the names of children born in Irbed in 1950.

c. mean of your credit card balances for the past three years.
d. the percentage of brown eyed people in your class.

A magnetic tape is an example of:

a. direct access storage device.

b. random access storage device.

C. sequential access storage device.

d. straight line access storage device.

Temporary, or volatile, storage is also known as:

a. RAM. b. ROM. c. Megs. d. disk.
When you delete a file:

a. A copy of the file will be sent to the desktop

b. You send the file to the Recycle Bin.

c. The file will not be affected.

d. A copy of the file will be stored in your active folder.

Which of the following statements is correct about opening control panel:

a. You can open control panel from windows explorer.

b. You can open control panel from settings on start menu.

c. You can open control panel from my computer.

d. All of the above.

Control Unit (CU) is the:

a. Main unit of the computer and sometimes is called the brain of the computer
b. Unit that controls and coordinates all other computer components

c. Main memory of any computer system
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d. Unit that is responsible for performing all the computer calculations
The documents that is located in start menu store:

a. The last 15 files that you have open.

b. The last 15 files that you have delete.

c. The |ast 15 files that you have copy.

d. None of the above.

The term "end user" is used to describe people who:

a. use the output from computers (the end product).

b. write software for computers.

C. use computers to perform information processing tasks.

d. are the last to use a computer or the information from a computer.
The desktop is:

a. An example of a hardware device.

b. A folder.

c. Afile

d. A window.

When you select MS-Prompt from program on start menu:

a. You will move to DOS window.

b. You will close your computer.

c. You will close DOS window.

d. None of the above.

The Shutdown icon on start menu means:

a. Close all windows.

b. Close the current windows.

c. Close your computer.

d. None of the above

To open a minimized window, you can click on the:

a. window’s button on the body of the taskbar.

b. maximized button on the title bar.

c. restore button on the title bar.

d. all of the above.

When you select find icon from start menu and you type ?7??.txt, this mean
that:

a. The computer will find all files that have extension txt only.

b. The computer will find all files that have anly three letters with all
extensions.
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c. The computer will find all files that have three letter and extension txt
only.

d. None of the above.

When you select find icon from start menu and type $*S.doc, this means
that:

a. The computer will find all files that have extension doc only.

b. The computer will find all files that have only three letters and extension is
doc.

c. The computer will find all files that have first and last letter is S and
extension is doc.

d. None of the above.

The ADD New hardware icon on control panel is used to:

a. Add new hardware to your computer.

b. Delete some hardware from your computer.

c. Stop the work of some hardware.

d. None of the above.

The easiest way to move a file from one folder to another in windows95 is
to:

a. Use Copy and Paste.

b. Use Cut and Copy.

c. Use Drag and Drop.

d. Use Cut and Drop.

You can slow or fast the movement of the mouse from the:

a. Mouse icon on control panel.

b. System icon on contral panel.

c. Add/Remove program icon on control panel.

d. None of the above.

To launch an application in Windows, you can on its icon.
a. Click b. Drag

c. Double click d. none of the above

We can copy, move, paste and rename files and folders by using:

a. Windows explorer. b. My computer.

c. A and B. d. None of the above.

The term "end user" is used to describe people who:

a use the output from computers (the end product).

b write software for computers.

c use computers to perform information processing tasks.
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d. are the last to use a computer or the information from a computer.
Microcomputers are divided into two general categories:

a. high speed and low speed.

b. graphical and non-graphical.

c. portable and desktop.

The name for the kind of software that performs tasks like word processing
or database management is:

a. DOS.

b. system software.

c. application software.

d. operation software.

Software used to interact between user programs and the computer is
called:

a. application software.

b. system software.

c. operation software.

d. custom made software.

8. An example of data is:

a. the average rainfall in Texas for 1995.

b. the number of children born in Chicago in 1950.

c. mean of your credit card balances for the past three years.

d. the percentage of brown eyed people in your class.

Windows 95 is an example of a(n):

a. operating system.

b. graphical user interface.

c. application software.

d. basic tools

Integrating video, voice, music and even graphics in a presentation is called:
a. combination packages.

b. multimedia.

c. mega-multi-media.

d. simulcast.

The most common input hardware for personal computers are:
a. a mouse and keyboard.

b. a keyboard and a screen.

c. a graphical user interface (GUI) and a mouse.

d. a printer and a monitor.
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The two main parts of the system unit are:

a. a mouse and a keyboard.

b. the CPU and memory.

C. a printer and a monitor.

d. primary storage and secondary storage.

When you double-click on an icon, you will:

a. Highlight it b. Disable it c. Open it d. Select it

Which of the following statement is correct about the arrange icon on disk
top:

a. lcons on disk top can arranged by name.

b. Icons on disk top can arranged by type.

c. lcons on disk top can arranged by size.

d. All of the above.

Which of the following statement is correct about range icons on disk top,
when auto arrange enable:

a. You can arrange icons, as you like.

b. The computer arranges icons on disk top.

c. The computer arranges icons in random location on disk top.

d. None of the above.

When you select properties from context menu of disk top, you will open:
a. Display properties. b. Taskbar properties.

c. Control panel. d. None of the above.

The option of minimize all windows that appear when you click right mouse
button on task body mean:

a. Minimize all windows that opening on disk top to be located on task body.
b. Maximize all windows from task body to be open on disk.

c. Close all windows.

d. None of the above.

You can add or remove programs to or from start menu by using:

a. Display properties. b. Taskbar properties.

c. Recycle bin. d. None of the above.

Which of the following statement is correct about opening control panel?
a. You can open control panel from windows explorer.

b. You can open control panel from setting on start button.

c. You can open control panel from my computer.

d. All of the above.
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The printer icon that located in my computer or from setting on start
button means

a. Add new printer to your computer.

b. Add new hardware to your computer.

c. Add new software to your computer.

d. None of the above.

The documents that locate in start button store:

a. The last 15 files that you open it.

b. The last 15 files that you delete it.

c. The last 15 files that you copy it.

d. None of the above.

When you select MS-Prompt from program on start button:

a. You will move to DOS window.

b. You will close your computer.

c. You will close DOS window.

d. None of the above.

The Shut Down icon on start button mean:

a. Close all windows. b. Close the current windows.

c. Close your computer. d. None of the above.

When you select find icon from start button and you write the ?77?.txt, this
mean:

a. The computer will find all files that have extension txt only.

b. The computer will find all files that have anly three letters with all
extension.

c. The computer will find all files that have three letter and extension txt only.
d. None of the above.

The ADD New hardware icon on control panel mean:

a. You can add new hardware to your computer.

b. You can delete some hardware from your computer.

c. You can stop the work of some hardware.

d. None of the above.

The Add/Remove programs icon on control panel mean:

a. You can add new programs to your computer.

b. You can remove programs from your computer.

c. A and B.

d. None of the above.
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The Date/Time icon on control panel used to:

a. Change computer time.

b. Change computer date.

c. Aand B.

d. None of the above.

You can slow or fast the mouse moving from the:

a. Mouse icon on control panel.

b. System icon on control panel.

c. Add/Remove program icon on control panel.

d. None of the above.

The computer is:

a. a collection of electronic circuits and devices.

b. an intelligent machine.

c. a combination of hardware and software of hardware and software.
d. all of the above.

You can change the background of disk top from:

a. Taskbar properties.

b. Add/Remove programs on control panel.

c. Display properties.

d. None of the above.

Screen Saver enables you to:

a. Save the power dissipated by computer when you leave it operates alone.
b. Protect your computer from accessing by other users when you make
password enabled.

c. Display another picture for your screen after specified time.
d. All of the above.

You can change the icon of any shortcut on disk top by:

a. Right click on the icon and select properties.

b. Right click on the icon and select create shortcut.

c. Triple click of mouse on the icon.

d. None of the above.

We can copy, move, paste and rename by using:

a. Window explorer. b. My computer.

c. A and B. d. None of the abhove.

1. The number of bits in a byte is:

a.4 b. 8 c.16 d.32
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In MS-Excel, the formula bar is used to:

a. Show the current cell that is ready to accept data.

b. Show the name of the file that is open.

c. Show the address of the selected cell.

d. Show the mathematical function, logical function, or data for the selected
sell.

The information:

a. must be available at the right time and useful.

b. should be available within one minute.

c. Should have a good accuracy.

d. a+c.

The operating system is a computer program which has many functions,
one of these functions is:

a. Can link itself to other programs.

b. Can store huge amounts of data.

c. Managing computer files.

d. Used to store user programs and data.

The CPU refers to:

a. Centralism Processor Unit. b. Control Processing Unit.
c. Control Processor Unit. d. Central Processing Unit.
The CU:

a. Used to store the processed data in temporarily.

b. Used to control the processes in the CPU.

c. Used to control the output and the input units only.
d. Used to control the RAM only.

You can get the pop up context menu in win95 by:

a. Right-Click on the desktop.

b. Left-Click on my computer.

c. Left-Click start button, then select windows explorer inside programs
group.

d. Double-click my computer Icon.

You can change the screen saver in win95 through the:
a. Accessibility Options lcon in Control Panel windows.
b. System Icon in Control Panel windows.

c. Date/Time Icon in Control Panel windows.

d. Display Icon in Control Panel windows.
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In Ms-word, these Icons represent:

a. Saving a document, creating a new document, and open an existence
document.

b. Open a document, Undo Icon, and saving a document.

c. Saving a document, Closing Ms-Word, and creating a new document.
d. Closing a document, saving a document, and open a new document.
What is the command that lists all the files that have a second letteras b
without an extension:

a. dir ?b*.* b. dir b?.

c. dir ?b*. d. dir 7b.?

What is the command that lists all the files in the directories and
subdirectories with their information:

a.dir*.*/p b. dir *.*/w

c. dir *.*/s d. dir *.*/oe

The abbreviation of www, which is used in the Internet, represents:
a. World Wide Web b. Wide World Web

c. Web World Wide d. Web Wide World

The ftp stands for:

a. File transfer program b. File transfer Protocol

c. File text program d. File text protocol

The most popular net browsers are:

a. Netscape and ftp

b. The Internet Explorer and the ftp

c. Netscape and the Internet Explorer

d. The Internet Explorer and the email

Email message consists of:

a. Header, body and signature (footer).

b. Body only.

c. Signature (footer) only.

d. None of the above.

Using the Internet you may:

a. Send and receive email messages

b. Transfer data files to and from computers around the world.

c. Share point of view on specific subjects with other online groups.
d. All of the above.

A machine with 32M of RAM has a capacity of how many bytes?
a. 33554432 b.32768
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c. 3200 d. 32000000

How many bytes are required to store the word SUMMER in computer
memory?

a.7 b.6 c.48 d.8

The memory (RAM) of a personal computer is part of the system's

a. operating system b. hardware c. software

The ASCII character set uses how many bits to represent each character?
a.8 b.256 c. 16

When your Hard Disk is infected with a virus, then the first thing you should
do:

a. copy all your files to a floppy diskette

b. clean the virus from a clean floppy diskette

c. shut down the computer and turn it on again

d. copy the infected files to a diskette and continue working

The CPU consists of:

a. ALU, CU, and RAM. b. ROM, ALU, and RAM.

c. CU, PU, and ALU. d. ALU, Registers, and CU.

The Main Memory:

a. Is consisting of RAM, ROM, and Hard Disk.

b. Could be temporarily or permanent.

c. Used to store user programs and data while running.

d. b+c.

When your Hard Disk is infected with a virus, then the first thing you should
do:

a. Copy all your files to a floppy diskette

b. Clean the Hard disk from a cleaned floppy diskette.

c. Shut down the computer and turn it on again

d. Copy the infected files to a diskette and continue working
The Magnetic Disk:

a. Classified as a secondary storage.

b. It is cheap and volatile.

c. It is an output unit.

d. a+b.

Which of the following statement is correct:

a. Mini-computers more powerful than mainframes

b. Micro-computers such as laptops.

c. Mini-computers are suitable for personals.
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d. Mainframes are suitable for small companies.
The computer viruses has the ability to:

a. Link it self to other programs.

b. Compress itself.

c. Coordinates the activities of the computer.

d. Make backups of your files.

Which of the following is not correct:

a. A computer virus is a system program designed to destroy other programs.
b. If the floppy disk is write-protect, the virus cannot infect the files.

c. If the computer speed decreased, a virus could infect the computer.

d. F-prot is one of the unti-virus programs.

When your Hard Disk is infected with a virus, then the first thing you should
do:

a. Copy all your files to a floppy diskette

b. Clean the Hard disk from a cleaned floppy diskette.

c. Shut down the computer and turn it on again

d. Copy the infected files to a diskette and continue working

e. None of the above.

The sound plaster is:

a. An output unit only.

b. An input unit only.

c. Both of the above.

d. None of the above.

An operating system is a computer program which has many functions, one
of these functions is:

a. Can link it self to other programs.

b. Can store huge amounts of data.

c. Managing computer files.

d. Used to store user programs and data.
The CPU consists of:

a. ALU, CU, and RAM.

b. ROM, ALU, and RAM.

c. CU, PU, and ALU.

d. ALU, Registers, and CU.

The computer viruses has the ability to:
a. Copy itself.

b. Compress itself.
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c. Coordinates the activities of the computer.

d. Make backups of your files.

Network Neighborhood:

a. Displays drives, and printers on your system available to the network.

b. Displays resources available to you on your network.

c. Will guide you through a step-by-step process of connecting to the
network.

d. is a file contains the names of the network neighborhood.

The easiest way to move a file from one folder to another in windows95 is:
a. Copy and Paste. b. Cut and Paste.

¢. Drag and Drop. d. Cut and Drop.

Using e-mail, you can:

a. Send a message to your friend if you know his/her address.

b. Send a message to yourself.

c. Send a message to several friends together, if you know their addresses.
d. All of the above.

You are preparing a letter in Notepad and your computer reboots without
your saving the file, can you recover what you had written?

a.Yes b.No

Which of the following is true regarding deleted files in Windows?

a .Once the files have been deleted, there is no scope left for recovering
them

b .The last 100 files that have been deleted can be recovered

¢ .The deleted files are sent to a Recycle Bin

d. Deleted files can be recovered as long as the computer has not been
switched off

How do you copy text matter in Notepad to the computer buffer?

a .Press Ctrl and V b. Press Ctrl and C

c .Press Ctrl and K d. Press Ctrland F

How do you paste text matter into a Notepad text file?

a. Press Ctrl and V b. Press Ctrland C

c. Press Ctrl and K d. Press Ctrland F

1. The of the computer is composed of an arithmetic-logic unit
and a control unit.

a. ALU b. system unit

c. CPU d. motherboard
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4, The acronym ALU stands for:

a. Applied Logical Unity.

b. Arithmetic Logic Unit.

c. Array of Logistical Units.

d. Absolute Lower Utility.

The ALU performs:

a. Input and Output operations.

b. Absolute and Lateral operations.

c. Memory and I/O operations.

d. Arithmetic and Logical operations.

Data that is stored in RAM:

a. is there until it is replaced.

b. is only there while the power is on.

c. remains only a few minutes after the power is turned off.

d. is permanent and only lost in a power failure.

All the information used by the processor is loaded first into:

a. REM. b. ROM. c. RAM. d. a disk.
9. The binary numbering system consists of unique digits.
a.16 b.8 c.2 d.1

11. A single character can be represented by 8 bits. Another name for 8 bits
is a:

a. Meg. b. string. c. binary digit. d. byte.
14. One kilobyte is approximately a bytes.

a. thousand b. million c. billion d. trillion

15. One megabyte is approximately a bytes.

a. thousand b. million c. billion d. trillion

16. One gigabyte is approximately a bytes.

a. thousand b. million c. billion d. trillion

What does the CTRL+U shortcut accomplish in Word 2000?
a. It underlines the selected word

b. It converts the selected word to uppercase

c. It undeletes the last deleted word

d. It undoes the last action performed in Word 2000

What is a page break in Word 20007

a. An instruction to the printer to print a new page

b. The point at which one page ends and another page begins
c. It refers to dividing a page into 2 parts vertically
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d. It refers to dividing a page into 2 parts horizontally

which shortcut key combination will allow you to check the Spelling of your
complete document?

a.F1 b.F2 cF3 d.F7

If you have a document typed in lowercase, how can you convert the whole
document into uppercase?

a. select the document text and choose the 'All caps' option under the menu
Format ->Style

b. select the document text and choose 'Corporate' under the menu Format -
>Theme

c. select the document text and choose the 'All caps' option under the menu
Format ->Fonts

d. There is no such option available in Word 2000

How are spelling errors displayed In Word 20007

a. A green wavy line under the wrong spelling

b. The word with the wrong spelling has strikethrough font

c. A red wavy line under the wrong spelling

d. The color of the word with the wrong spelling will change to red

This question is based upon the figure shown below

j{’z - 'ﬁv-_ﬁr‘ '&"
- @ E- Al

Which Word 2000 toolbar is shown in figure?

a. Forms toolbar

b. Formatting toolbar

c. Autotext toolbar

d. Tables and Borders

e. Database toolbar

f. Drawing toolbar

You are required to prepare an essay in Word 2000 consisting of only 250
words. What is the most convenient way for you to count the total number
of words in your document?

a. First justify the document (both left and right justified), then count the
number of words on one line, and multiply them by the number of lines

-

-1
SR
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b. Select the text whose words you require to count and right-click the mouse
button. Choose the "Words count' option

c. Choose the "Words count' option under the Tools menu

d. Choose the 'Paragraph statistics' option under the View menu

e. Count each word one by one. There is currently no tool available for
counting the number of words

What does the CTRL+l shortcut accomplish in Word 20007

a. It converts the selected text into the next larger size of the same font

b. It adds a line break to the document

c. It makes the selected text bold

d. It applies italic formatting to the selected text

What does the CTRL+B shortcut accomplish in Word 2000?

a. It converts the selected text into the next larger size of the same font

b. It adds a line break to the document

c. It makes the selected text bold

d. It adds a segment break to the document

How do you change the date and/or time of your PC?

a. Start MenuSettingsControl PanelDate and Time.

b. Double click on the time which is appear on the right of status bar.

c. Right click on desktop, then choose Time\Date.

d. a+b

When you select find icon from start menu and you type ?7??.txt, this mean
that

a. The computer will find all files that have extension txt only.

b. The computer will find all files that have anly three letters with all
extensions.

c. The computer will find all files that have three letter and extension txt only.
d. None of the above.

In order to save an existing document with a different name you need to:
1. Retype the document and give it a different name

2. Use the Save as.. command

3. Copy and paste the original document to a new document and then save
4. Use Windows Explorer to copy the document to a different location and
then rename it

Which keyboard shortcut bolds selected text?

1. Ctrl+B 2. Alt+B

3. File/Format/Bold 4. None of the above
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How can you highlight text without using the mouse?

1. It is impossible

2. Use the F5 key

3. Use the arrow keys while holding down a Ctrl key

4, Use the arrow keys while holding down a Shift key

What would you see while spell checking the phrase "My father was
write"?

1. The word "write" is misspelled

2. No errors

3. The verb of the phrase will be highlighted

4, A blue squiggly underline under the word "write"

Suddenly Word does not display your favorite toolbar. What has
happened?

1. Your program has been infected by a macro virus

2. This version of Word does not support toolbars

3. Your toolbar option has been deleted from the menus

4, Your toolbar has been unchecked under the View/Toolbars Menu
In page preview mode

1. You can see all pages of your document

2. You can only see the page you are currently working

3. You can only see pages that do not contain graphics

4. You can only see the title page of your document

Which elements of a Word document can be displayed in color?
1. Only graphics

2. Only text

3. All elements

4. All elements, but only if you have a color printer

In order to create columnar data in Word you need to:

1. Tab consecutively until you cursor reaches the desired place

2. Set tabs or use the Table menu

3. You need to use Excel

4. Press the space bar until your cursor reaches the desiredPlace
The background of any Word document:

1. Is always white color

2. 1s the color you preset under the Options menu

3. Is always the same for the entire document

4. Can have any color you choose
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In Word you can force a page break:

1. By positioning your cursor at the appropriate place and pressing the F1 key

2. By using the Insert/ Break /page break

3. By positioning your cursor at the appropriate place and pressing
SHIFT+Enter

4. By changing the font size of your document

What is the default file extension for all Word documents?

1. TXT 2. WRD 3. FIL 4. DOC
Which key moves your cursor from one cell to the next in a table?
1. Tab 2. Shift 3. Enter 4. Ctrl+Enter

How many different documents can you have open at one time?
1. No more than three

2. 0nly one

3. As many as your computer memory will hold

4. No more than your Taskbar can display

which keystroke will take you at the beginning or the end of a long
document?

1. Ctrl+PageUp and Ctrl+PageDown

2. Shift+Home and Shift+End

3. Ctrl+Home and Ctrl+End

4. The only way is by using the right scroll bar

How many margins are on a page?

1. Two (header and footer)

2. Four (top, bottom, right, left)

3. Two (landscape and Portrait)

4. Two (top and bottom)

In order to save a Word document as a web page you need to:

1. Put the appropriate graphics and links on the document

2. Save the document in simple text format

3. Use your web browser as an editor and save as URL
4, Save as HTML

Can you change the background picture of a Word 2000 Theme that has

been applied to a page

a-yes b-no

One terabyte is approximately a bytes.

a. thousand b. million c. billion d. trillion
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This question is based upon the figure shown below:

am D DL ot Ol | F =

Which Word 2000 toolbar is shown in the figure!
a .Standard toolbar

b .Formatting toolbar

¢ .Autotext toolbar

d .Clipboard toolbar

e .Database toolbar

f .Drawing toolbar

%< u

g .Picture toolbar
Can you give a 3D (3 Dimensional) effect to your text and graphics using
Word 2000

a.Yes b.No

This question is based upon the figure shown:

e

When you right-click in a cell of a table placed in IR paste
your Word 2000 document you can see the
properties and options as shown in the figure.

The split cells option has been highlighted in the
figure. What is the function of this option?

I Insert Table. ..
Delete Cels. ..
12 Split Celks...

a .It divides an existing cell horizontally into 2 Borders and Shading. .,
equal cells @Te“& Direction, ..

b .It divides an existing cell vertically into 2 equal =] cell alarment »
cells AutoFk b
¢ .It allows you to divide an existing cell of a table Tehe Properties. .

into more rows and columns 3= Builets and Nuplie o

d .It allows you to merge 2 or more existing cells R R -
with one another W, Hyperirk..

How many different documents can you have open at one time?
1. No more than three

2. Only one

3. As many as your computer memory will hold

4. No more than your Taskbar can display
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which keystroke will take you at the beginning or the end of a long
document?

1. Ctrl+PageUp and Ctrl+PageDown

2. Shift+Home and Shift+End

3. Ctrl+Home and Ctrl+End

4. The only way is by using the right scroll bar

How many margins are on a page?

1. Two (header and footer)

2. Four (top, bottom, right, left)

3. Two (landscape and Portrait)

4. Two (top and bottom)

In order to save a Word document as a web page you need to:

1. Put the appropriate graphics and links on the document

2. Save the document in simple text format

3. Use your web browser as an editor and save as URL

4. S5ave as HTML

Can you change the background picture of a Word 2000 Theme that has
been applied to a page?

a.Yes b .No
Another name for the system board is the:
a. chipboard.

b. motherboard.

c. daughterboard.

d. integrated circuit.

Chips that have built-in programs stored in them are called:
a. RAM. b. ROM.

c. extended memory. d.cache memory.

The keys labeled 0 -9 on the keyboard are called:

a. function keys. b. numeric keys.

c. typewriter keys. d. special purpose keys

The keyboard keys that have arrows on them are called:

a. function keys. b. navigation keys.

c. typewriter keys. d. special purpose keys.

The keyboard keys like Caps Lock that turn a feature on or off are called:
a. function keys. b. Special purpose keys.

c. Toggle keys d. Combination keys.
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A mouse, touch screen, and trackball are all examples of:

a. scanning devices. b. voice-input devices.

C. pointing devices. d. output devices.

The input device that rolls on a desktop and controls the position of the
cursor on the screen is called a:

a. touch screen. b. light pen.

c. digitizer. d. mouse.

A device that records images of text, or converts printed text into machine
readable form is called a

a. pointing device. b. scanner. C. printer. d. plotter.

The keyboard keys that are labeled F1, F2, and so on are called:

a. function keys. b. numeric keys.

C. typewriter keys. d. special purpose keys.

The smallest unit of an output device display is called a:

a. pixel. b. picture unit. c. VDT. d. monitor.
Images and information produced on paper is called output.
a. soft copy b. medium copy

c. hard copy  d. document quality

A fast, draft quality, low-cost printer is the printer.

a. laser b. dot matrix c.ink jet d. thermal
The printer that sprays small droplets of ink on to the surface of the paper
is the printer.

a. laser b. dot matrix c.ink jet d. thermal

The printer that creates dot-like images using a beam of light is the
printer.

a. laser b. dot matrix c.ink jet d. thermal

The general name for devices that convert machine-readable information
into people-readable form is:

a. input devices. b. scanning devices.

c. conversion devices. d. output devices.

A printer is produces low-quality print and is inexpensive.

a. laser b. dot matrix c.ink jet d. thermal

A specialized output device for producing charts, maps, and very high
quality drawings is a:

a. printer. b. plotter. C. scanner. d. imager.

A magnetic tape is an example of:

a. direct access. b. random access.
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C. sequential access. d. straight line access.

Secondary storage is , Which means it keeps its data after the

power is turned off.

a. volatile b. sequential c. direct d. non-volatile

A removable floppy-disk cartridge with 100 MB of capacity is called a
disk.

a.Zip b. mega C. monster d. cache

The data on a floppy disk is recorded in rings called:

a. sectors. b. ringers. c. roundels. d. tracks.

The method of increasing the amount of data stored on a disk by replacing
repeating patterns is:

a. file compression. b. data access.

c. disk caching. d. RAID.

A WORM CD-ROM drive allows the user to:

a. read stored data faster than a CD-ROM.

b. read and write data like a hard drive.

c. distribute large volumes of data quickly.

d. write data once, but read it many times.

A CD-RW disk:

a. has a faster access than an internal disk.

b. can be erased and rewritten.

c. is a form of optical disk, so can be only written once.
d. holds less data than a floppy disk.

A DVD device can store:

a. as much data as a CD-ROM.

b. as much data as 100 floppy disks.

c. more data than several CD-ROMs.

d. digital data in an expanded format.

Which of the following is an example of an input unit:

a. Keyboard b. Mouse c. Screen d AandC

ROM stands for:

a. Read optical memory. b. Random only memory.
c. Read only memory d. Read online machine.

After processing the data it will be:

a. Input. b. Program

c. Custom software. d. Information
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Software works as intermediate between user and computer is called:

a. Application software. b. Operating system

c. Operation software. d. Excel.

Your computer may be infected with Virus by one of the following reasons:
a. Download files from internet. b. Using infected Disk.

C. using Anti Virus d. Both aand b.

The device that converts a graphical image to digital data is:

a. Printer b. Scanner c. ALU d. Screen

What is the function of a disk drive?

a) to print sheets of paper

b) to read from or write information to a floppy disk

c) to display information or pictures on a screen

d) to calculate numbers

all of the following are various types of printers except:

a) Dot-matrix. b) Ink-jet.

c) webcam. d) Laser.

Which of the following are computer languages?

a) Linux b) Windows 2000

¢) Word 2000 d) Visual basic

What is the maximum capacity for floppy diskette?

a) 1.2 MB b) 1.4 MIB c) 2.0 MB d) 1.4 GB

What is most commonly used to enter text into a word processing
program?

a) keyboard b) mouse c) printer d) monitor

Booting a computer means:

a. Install Programs.

b. Turning the computer off

Turning the computer on. And Loading operating system into RAM:
a. None of the above

When electrical power is cut off, data and programs are lost in:

a) Secondary storage. b) ROM.

c¢) Primary memory. d) Operating system.
WWW is an abbreviation for:

A. Wide World Web B. World Wide Web

C. Wide Web World D. Web World Wide
The temporary memory of the computer is

a) ROM b) REM c) RAM d) BIOS
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What computer component is labeled with the number 3 on the diagram?

B o o e, | g | o Bt | il |

e N
===

5 -
a) CPU b) Laser Printer
c) Mouse d ) Keyboard
All of the following are examples of secondary storage devices except:
a) Magnetic Tapes. b) Printer
c) Magnetic Disks. d) Hard Disks.

A computer user can notice that there is a virus if he/she observes a:
a) Lack of storage capability.

b) Decrease in the speed of executing programs.
C ) Unexpected error messages.

d) All of the above.

Input and output devices are really just:

a. direct entry devices.

b. remote entry devices.

c. translators.

d. ASCIl coders.

is an example of keyboard entry.
a. Working from a source document

b. Using a hand scanner

c. Using a wand reader

¢. Working with 2 POS terminal
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A POS terminal is an example of:
a. source document entry.

b. keyboard entry.

c. direct data entry.

d.bandc.

The keys labeled 0 -9 on the keyboard are called:

a. function keys. b. numeric keys.

C. typewriter keys. d. special purpose keys.

The keyboard keys that resemble regular letters on the keyboard are called:
a. function keys. b. numeric keys.

C. typewriter keys. d. special purpose keys.

The keyboard keys that are labeled F1, F2, and so on are called:

a. function keys. b. numeric keys.

C. typewriter keys. d. special purpose keys.

The keyboard keys that have arrows on them are called:

a. function keys. b. navigation keys.

C. typewriter keys. d. special purpose keys.

The keyboard keys like Caps Lock that turn a feature on or off are called:
a. function keys. b. Special purpose keys.

c. Toggle keys d. Combination keys.

To protect your Data from computer viruses you should:
a) Buy original copies (of software).

b) Make backups of your files.

¢) Use anti-virus programs (e.g. f-prot)

d) All of the above

Continuous-speech and discrete-speech are two forms of:
a. speech recognition systems.

b. mark sense systems.

c. optical-auditory access systems.

d. interactive input systems.

Using the computer can recognize phrases like "He won the
game" in context.

a. discrete speech

b. continuous speech

c. artificial speech

d. artificial intelligence
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The general name for devices that convert machinereadable information
into people-readable form is:

a. input devices. b. scanning devices.

C. conversion devices. d. output devices.

The printer that sprays small droplets of ink on to the surface of the paper
is the printer.

a. laser b. dot matrix c.ink jet d. thermal

The printer that creates dot-like images using a beam of light is the
printer.

a. laser b. dot matrix C.ink jet d. thermal

A very high quality printer that uses heat and specially treated paper is the
printer.

a. laser b. dot matrix C.ink jet d. thermal

A terminal that cannot process any information is called a(n):

a. direct access terminal. b. intelligent terminal.

c. smart terminal. d. dumb terminal.

A terminal that is essentially a PC with some communications software on

board would be called a(n):

a. direct access terminal. b. intelligent terminal.

c. smart terminal. d. dumb terminal.

The standard size for flexible disks is currently

a.2.5inches. b.3.5inches. c. 5.25inches. d. 8 inches.

A removable floppy-disk cartridge with 100 MB of capacity is called a
disk.

a.Zip b. mega c. monster d. cache

If the notch on a diskette is closed,

a. data cannot be read from the diskette.

b. data cannot be stored on the diskette.

c. the diskette cannot be inserted into the computer.

d. the diskette is completely unusable.

The data on a floppy disk is recorded in rings called:

a. sectors. b. ringers. c. roundels. d. tracks.

The floppy diskette that has a capacity of 100 Megabytes of information is

the:

a. floppy diskette. b. 2HD diskette.

c. Zip disk. d. Mega-disk.
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The popular floppy diskette that has an exterior jacket made of hard plastic
is the:

a. 2.5 inch diskette. b. 3.5 inch diskette.

c. 5.25 inch diskette. d. 8 inch diskette.

A magnetic tape is an example of:

a. direct access. b. random access.

C. sequential access. d. straight line access.

Secondary storage is , Which means it keeps its data after the
power is turned off.

a. volatile b. sequential c. direct d. non-volatile

Programs used to create or modify bitmap files are called:

a. illustration programs.

b. image editors.

c. graphical modifiers.

d. bit publishing packages.

Programs used to create or modify vector images are called:

a. illustration programs.

b. images editors.

c. graphical modifiers.

d. bit publishing packages.

CorelDraw is an example of a(n):

a. groupware application.

b. image editor.

c. illustration program.

d. graphics suite.

A collection of graphics programs and supporting data files is called a:
a. groupware application.

b. freehand package.

c. graphics suite.

d. shared program collection.

One difference between desktop publishing and word processing is:
a. that desktop publishing allows you to create documents that have
professional quality layout and type styles.

b. the first uses graphics, the second uses text.

c. that word processing allows the user to add graphics to a document,
desktop publishing doesn't.
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d. important because word processors work at the command line, but
desktop processors work with graphics.
The smallest element of data addressed in a file is a

a. bit. b. character. c. field. d. record.

A single letter, number, or special character like a * is called a:

a. bit. b. character. c. field. d. record.

A set of related characters, like a social security number, is called a:

a. bit. b. byte. c. field. d. record.

A collection of related fields, like your grades in this class, is referred to as a
a.character. h. record. c. file. d. database.

A collection of related records, like all the student grades at your school, is
called a:

a. field. b. record. c. file. d. database.

A collection of related files is called a:

a. field. b. record.

c. master record. d. database.

The unique field used to identify each record in a database is called the
field.

a. master b. key c. relational d. prime

To be a key field, the data in the field must:

a. be unique for each record.

b. be longer than other fields.

c. contain both letters and numbers.

d. be one of the first three fields.

Collecting data over a period of time, and then processing it all at once is
called processing.

a. transaction

b. real-time

c. master file

d. batch

Processing each transaction as it happens is an example of
processing.

a. transaction

b. real-time

c. master file

d. batch
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In the early days of computers, tape was the only secondary storage, so all

transaction processing was in mode.

a. real-time.

b. master file

c. batch

d. tape transfer

A file contains all the current records since the last update.
a. master b. transaction c. record d. base
A file contains the updates to the current records.

a. master b. transaction c. record d. update
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